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Manual Conventions 
This manual uses different fonts to highlight specific features, to identify data that Windows 
will display, or input that you must type.

Throughout this manual, you will see references to Windows. Windows refers to Microsoft® 
Windows NT, Windows 95 or Windows 98. You will need one of these operating environ-
ment to run FEMAP for the PC. This manual assumes that you are familiar with the general 
use of the operating environment. If you are not, you can refer to the Windows User’s G
for additional assistance. 

Similarly, throughout the manual all references to FEMAP, refer to the latest version of
software.

Enter, Alt Shows one or more keys that you should press. In some 
cases, you will see combinations like Alt+Shift+Back-
space. The plus signs show that you should press all keys 
simultaneously.

a:setup Shows text that you should type. This is very similar to 
the keystrokes described above, but is typically used for 
strings of letters and/or numbers. The keystrokes typi-
cally refer to the more specialized, non-alphanumeric 
keys.

OK, Cancel Shows text that you will see displayed by FEMAP in a 
dialog box control, or in the menu.

heading Used for headings or titles of sections of the manual. 
Larger characters of the same style (or italics) are also 
used depending upon the nature of the section being 
introduced.

text Used for all other normal manual text.
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1New Features

This document includes updated information for the documentation provided with 
FEMAP Version 7.1. The information in this document and in the Help system is 
more up-to-date than that in the manuals. Also check our web site  http://
www.femap.com  for additional information. 

1.1  FEMAP Enterprise
Version 7.1 represents the first release of FEMAP Enterprise. This new product con-
tains a broad range of new geometry interfaces, including:

CATIA Import - Provides the ability to read CATIA model files, and Express files 
from CATEXP. Catia model files must be from CATIA v4.1.x or v4.2

IGES Import - in addition to the basic IGES interface that is included in FEMAP 
and FEMAP Professional, an advanced IGES interface that supports many additional 
entity types is included in FEMAP Enterprise. This supports IGES Standards 4.0 to 
5.3.

VDA Import - this interface provides direct access to VDA files up to v2.0

IDEAS Import - Provides access to IDI files generated by I-DEAS MS8. Currently 
only part (not assembly) geometry is supported, but this provides a very fast, very 
robust link between FEMAP and I-DEAS

PRO/E Import - Provides direct access to model files from PRO/ENGINEER v16 
to v20. From other versions of PRO/E, the IGES interfaces will continue to provide 
very robust geometry transfer.

Solid Edge Import - Direct access to Parasolid geometry in Solid and Sheet Metal 
part files.

Unigraphics Import - Direct access to Parasolid geometry from Unigraphics v11 
thru v15

ACIS and Parasolid Import - Both of these interfaces provide the ability to convert 
the imported geometry to the other solid modeling engine. If you normally, work 
with Parasolid, but you have some ACIS geometry that you need to use, this lets you 
convert it to Parasolid so that it can fully interact with your other geometry.

IGES Export - in addition to advanced IGES import, it is now possible to export 
Parasolid geometry to IGES format.



 ��� New Features
1.2  Updated Interfaces

1.2.1  ABAQUS Interfaces
An option has been added to use the entity titles as the titles for SET commands. 
Added support for the *INCLUDE command and INPUT= options on various com-
mands for the model read interface.

1.2.2  ANSYS Interfaces
Corrected a problem with the TSHAP command when writing triangular contact ele-
ments. Corrected a problem with the TBPT command for stress-strain curves on non-
linear plastic materials.

1.2.3  I-DEAS Interfaces
Added an interface to read I-DEAS part geometry from the IDI (Interoperability 
Data Interface). Significantly improved and updated the I-DEAS Universal File 
interfaces to include more model data, including some basic capabilities to read 
nodal results and solid element stresses.

1.2.4  LS/DYNA Interfaces
Corrected a problem that caused the Springback and Implicit solver options to be 
reversed. Also improved support for postprocessing of some older versions of 
DYNA by providing an option that allows you to force each new step to start in a 
new file.

1.2.5  NASTRAN Interfaces
Significantly improved the performance of writing NASTRAN model files that have 
both a large number of enforced displacements and a large number of constraints 
(25000 or more each). Added warnings if you attempt to write laminates without a 
material orientation, or if you specify plate offsets but then translate to a plate type 
that does not support them.

1.2.6  UAI/NASTRAN Interface
Stopped writing MAT4 and MAT5 cards which were written incorrectly for UAI/
NASTRAN and were not required for the structural analysis types that the UAI inter-
face supports.

1.3  Picking and Common Dialogs

1.3.1  Standard Coordinate Dialogs
The "In Workplane" coordinate definition dialog now properly switches labels as 
you toggle between polar and rectangular coordinates.



 Entity Selection ���
1.3.2  Entity Selection
If you press the Alt-key while picking, and you are in either normal selection mode, 
or "Front" selection mode, you will switch to Query Selection for that pick. This 
eliminates the need to manually change your selection when you have a few picks 
where query is needed. Added a Preview command to the Pick menu that shows the 
entities that have been selected.

1.4  File Menu Commands

1.4.1  Printing
Corrected a problem that occurred when you tried to print headers or footers, or a 
multiple window layout on certain DeskJet printers. These printers do not properly 
reset the clipping region during printing resulting in certain portions of the print 
being lost. An option has been added to File->Page Setup to manually reset the Clip-
ping Region that will overcome this problem. Added an option to print directly to a 
file instead of your printer.

1.4.2  File Preferences
Added a View Preference to use (or not use) Vertex Arrays in Render Mode. Vertex 
arrays are a feature of OpenGL that, if properly supported by your graphics card and 
drivers, allows improved graphics performance. Unfortunately, we have found cards 
that claim to support this feature that do not work properly when it is enabled. 

1.4.3  Sketching
Corrected a problem that caused FEMAP to crash if you attempted to do a File Exit 
while you were still in Sketch Mode.

1.5  Geometry

1.5.1  Surface Creation
Changed the way that surface are created by the Surface->Corners and Surface-
>Ruled commands when using the ACIS geometry engine. These surfaces now have 
their parametric directions created consistently with the other geometry engines. 
Also updated the height and width specifications for the Geometry->Surface->Planar 
command for the ACIS engine, so that it was consistent with the other engines.

1.6  Model Menu Commands

1.6.1  Model Material
User defined materials can not have text fields with no input field. Simply define the 
field as Axxx (xxx is any number) in the material definition file to create the text 
without an input field. Added a Fluid Material Type, additional phase change proper-
ties and support for ThermoOptical properties on some other standard material types.



 ��� New Features
1.6.2  Model Function
Added the capability to automatically create periodic functions by duplicating a 
range of values.

1.7  Meshing

1.7.1  Mesh Extrude Element
Improved the "Normals with Thickness Correction" method to better account for sit-
uations with multiple elements coming together at a node - for example at the corner 
of a box.

1.7.2  Meshing Surfaces
Corrected a problem that caused a mesh on a Boundary that was mapped to a surface 
to come out at the origin, rather than on the surface, if you smoothed the mesh.

1.7.3  Mesh Points on Surface
The Mesh Points on Surface command has been updated so that you can easily create 
new mesh points, use existing points, connect to existing nodes in another mesh, or 
delete the points that you have already assigned.

1.7.4  Multi-Surface Meshing
Whether it is called Multi-Surface Meshing, Compound Surface Meshing, Section 
Meshing, or some other name, this tool provides the ability to consider multiple sur-
faces as one and mesh across the combined group of surfaces as if they were a single 
surface. Interior boundaries are simply ignored. Several new commands have been 
added to facilitate this operation. Geometry->Boundary Surface->From Surfaces on 
Solid lets you quickly create a boundary surface by picking multiple adjacent sur-
faces from a stitched solid. Geometry->Boundary Surface->Update Surfaces pro-
vides automatic updating of boundary surfaces that were created with the "From 
Surfaces on Solid" command, if the underlying solid geometry has changed. Geome-



 Meshing Solids ���
try->Boundary Surface->Edit Surfaces allows you to edit the definition of one of 
these Boundary Surfaces if you want to add or remove surfaces.

.

1.7.5  Meshing Solids
The solid meshing commands will search for a solid property and select it as the 
default if the active property is not a solid property.

Multi-Surface Boundary with
mapped mesh. Note how
boundaries of interior
surfaces are ignored

Individually Meshed Surfaces

Geometry

Geometry (dark outlines show edges of multisurface boundaries
interior hatching shows boundaries of individual surfaces)

Mesh - follows boundary outlines, and lies on surfaces, but
does not follow surface outlines.



 ��� New Features
1.8  Modify Menu Commands

1.8.1  Modify Project Mesh Onto Solid
Allows you to take a mesh and project it onto an entire solid or onto a group of sur-
faces from a solid. This can be used to mesh a planar outline of a region and then 
move the mesh onto the solid.

1.8.2  Modify Move By Offset Element
This command provides the capability to move elements along a vector, or along 
their element normals. Moving planar elements along their normals can be a simple 
way to create a midplane mesh of constant thickness parts - simply mesh either the 
inner or outer surfaces, and move the elements along their normals by one half of the 
thickness.

1.8.3  Modify Renumber Materials
Corrected a problem that caused function references on materials to be lost if you 
renumbered the material.

1.8.4  Modify Color
Added the ability to randomize surface colors. Changed the default color of a bound-
ary surface to be different than the normal surface color - this is intended to make the 
boundaries created by the new multi-surface meshing commands visible when dis-
played on top of the underlying surfaces.

1.8.5  Modify Update Elements Reverse
Previously when you reversed element directions, loads applied to the element faces 
would flip direction. This could also happen for axisymmetric elements that were 
built in an incorrect modeling plane and flipped automatically as you translated your 
model. Now the loads are properly adjusted to maintain their direction when the ele-
ments flip.

1.8.6  Modify Update Elements Split Quads
Corrected a problem that left the midside nodes of parabolic quads as nondeletable 
after you split them into triangles. Previously you had to run File Rebuild before you 
could delete these nodes.

1.9  List Menu Commands

1.9.1  List Loads
Significantly improved the speed of listing loads from sets that have a very large 
number of nodal or elemental loads. This is most evident in load sets with 20,000 
loads or more.



 Views and Graphics ���
1.10  Views and Graphics

1.10.1  View Rotate and Align
The View Rotate command has been changed to a submenu. The old View Rotate 
command can now be accessed via the View->Rotate->Model command. The same 
shortcut keys Ctrl+R or F8 still work as before. View->Align By->Dynamic has been 
moved to the new View Rotate menu, and new commands have been added to allow 
you to pick the dynamic rotation center and axis.

1.10.2  Free Face and Hidden Line
Significantly improved the performance of the computation of free faces in large 
solid models. This greatly improves the display speed on View Regeneration for Free 
Face and all Hidden Line displays outside of Render mode. It also improves perfor-
mance of other commands that require free face information - like picking free faces. 
Also corrected a problem in the usage of the "Free Edge and Face" View Option. 
Previously the Use Midnodes and Skip Midnodes options worked backwards for 
Free Face and Hidden displays.

1.10.3  Graphics
Corrected a problem that caused all graphics to disappear except the axes, origin and 
workplane. The problem was created if you closed a view within a couple of seconds 
from the time when you resized it. Previously the only ways out of this problem were 
to exit and restart FEMAP, or create a new view and resize it.

1.10.4  Render Mode
Corrected problems that occurred on several graphics boards/drivers. This includes 
problems with the GeForce cards (requires disabling Vertex Arrays in File Prefer-
ences).

1.10.5  Dynamic Rotation
The dynamic rotation command has been improved to allow dynamic rotation about 
a location other than the center of the screen, and about any vector/axis that you 
choose. New commands have been added to the View Rotate submenu to allow you 
to define these options, or you can define them from a new Options menu in the 
dynamic rotation dialog box. 

Dynamic rotation can now be done even if you have both curves and elements turned 
off for normal displays, as long as you have one or both of them in your model.



 ��� New Features
1.11  PostProcessing

1.11.1  Contour Postprocessing
Corrected a problem that gave invalid contours if you used elemental contouring on 
a plate model, and you chose either Max or Min data conversion (not averaging), and 
you turned on the display of plate thicknesses. 

1.11.2  Beam Diagram Postprocessing
Corrected a problem that occurred if you set the beam diagram direction to Elemen-
tal Y or Z, and you displayed the diagram on a deformed model, with a deformation 
scale that was large enough to cause the deformed beam X axis to pass through the 
element orientation vector. In this case the direction of the diagram was previously 
reversed - it is now drawn properly. Added support for beam diagrams of Beam 
Equivalent Stress, Beam Plastic Strain, Beam Total Strain and Beam Creep Strain 
when these values are recovered from your analysis.

1.11.3  Contour Vector Postprocessing
Corrected a problem that occurred on uniaxial solid models with solid elements that 
had 2 zero shear stresses. If you plotted a standard Max Principal Stress contour vec-
tor, the vectors on those elements was zero. It is now computed properly.

1.11.4  Section Cut Postprocessing
Added support for elemental contouring in a section cut display. Previously if you 
selected elemental contours with section cuts, all contour values were displayed as 
zero. 

1.11.5  Freebody Postprocessing
If you have multiple output sets, some with Freebody output, and others without, 
when you went into the Freebody dialog box, the graying was not handled properly 
unless you had selected the output set in a previous command. This problem has 
been corrected.
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